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Characterization of Human Keratinocyte
Cell Lines for Barrier Studies

Mary C. Moran1,2,3, Radha P. Pandya2,3, Kimberly A. Leffler2, Takeshi Yoshida2, Lisa A. Beck2 and
Matthew G. Brewer2
Epidermal cell models are critical for studying skin biology. The gold standard used by the scientific community
has historically been primary cell cultures from discarded tissue, typically from neonates (foreskin). Although
directly applicable to humans, this system suffers from multiple issues, including substantial donor-to-donor
variability and a finite number of divisions in culture. As such, we have identified a faithful alternative called
N/TERT2G cells. These cells show many of the characteristics of primary cells, including barrier formation,
differentiation kinetics and/or protein expression, and pathogenesis. From our observations, N/TERT2G cells
can serve as a reproducible and genetically manipulatable platform in studying skin biology.
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INTRODUCTION
The epidermis protects the body from pathogens, allergens,
irritants, and pollutants and limits water loss. Keratinocytes
(KCs), the main epidermal cell, undergo differentiation to
form four distinct layers: stratum basale, stratum spinosum,
stratum granulosum, and stratum corneum (SC). The physical
barrier of the epidermis is maintained by two structures. The
first is in the SC and consists of corneocytes surrounded by a
complex lipid matrix, and underneath this in the stratum
granulosum where cell-cell junctions called tight junctions
(TJs), are found.

Studies of the human epidermis have relied on primary
cells propagated as monolayers or bilayers or three-
dimensional organotypic raft cultures. Our laboratory and
many others have shown that differentiated primary KCs form
TJs in vitro, but they have multiple limitations, such as their
finite number of cell divisions. In addition, their supply is not
reliable, and there is a considerable variation in biological
assays, which may be a function of donor variation (e.g.,
anatomic location, health, sex, and age). This highlights the
need for a cell line that faithfully recapitulates primary KCs
with regard to cellular differentiation, barrier formation, and
TJ organization. Identification of such an alternative would
also provide an opportunity to genetically manipulate key
proteins to address their biological relevance.
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To address this, we compared the key features of three KC
types: primary human foreskin KCs (PHFKs), N/TERT2G cells
(immortalized PHFK, human telomerase, and spontaneous
mutation), and HaCaT cells (spontaneously immortalized
KCs) (Boukamp et al., 1988; Dickson et al., 2000). Previous
studies have independently compared HaCaTor N/TERT cells
with primary KCs, focusing on differentiation and SC for-
mation (Seo et al., 2012; Smits et al., 2017; van Drongelen
et al., 2014). They found that N/TERT cells grown as a hu-
man epidermal equivalent model are comparable with pri-
mary human KCs, with similar SC organization, SC
permeability, and differentiation marker expression (Smits
et al., 2017; van Drongelen et al., 2014). HaCaT cells
showed dissimilar responses to cytokine stimulation
compared with primary KC in the expression of cornified
envelope transcripts, suggesting that HaCaT cells are not a
suitable alternative to primary KC (Seo et al., 2012). We
extended these findings by comparing these KC cell lines
focusing on differentiation markers (at the protein level),
immunoreactivity of TJ proteins, physiological barrier func-
tion, and viral infectivity using in vitro monolayer models.
We show that N/TERT2G cells recapitulate PHFKs in differ-
entiation, TJ organization, formation of a functional barrier,
and susceptibility to viral infections.
RESULTS AND DISCUSSION
We first compared barrier function, measured by trans-
epithelial electrical resistance (TEER), in these different KC
models. PHFKs developed increased TEER (i.e., greater bar-
rier function) after differentiation was initiated by exposure to
high calcium media (1.8 mM) (Boston BioProducts, Ashland,
MA) (Figure 1a) (Bikle et al., 2012). Using the same differ-
entiation media, N/TERT2G cells also demonstrated
increased TEER over time after the initiation of differentiation;
however, TEER was statistically less in N/TERT2G cells at
three time points (Figure 1a). N/TERT2G cells reached peak
TEER earlier than PHFKs, in agreement with a previous study
showing that N/TERT2G cells differentiate more rapidly than
primary KCs (Smits et al., 2017). In contrast, HaCaT cells did
not form a robust barrier, as demonstrated by no increase in
estigative Dermatology. This is an open
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Figure 1. PHFKs and N/TERT2G cells form barriers and display similar OCLN immunoreactivity during differentiation. Cells were grown to confluence and

switched to media containing calcium (1.8 mM) to initiate differentiation (PHFK-, N/TERT2G-, HaCaT-matched culture conditions), HaCaT cells were grown in

recommended media (DMEM þ 10% fetal bovine serum and penicillin, streptomycin, and amphotericin additives). (a) TEER was measured for 6 Ds after

differentiation (n ¼ 5 PHFKs and N/TERT2G cells, n ¼ 3 HaCaT cells). Mann‒Whitney U test comparing PHFKs versus HaCaT cells (*), N/TERT2G cells versus

HaCaT cells (*), and PHFKs versus N/TERT2G cells (#) at each time point. (b) Immunofluorescence staining for OCLN at D2 and D4 after differentiation. Images

were captured at an exposure time of 850 ms (for PHFKs and N/TERT2G cells) or 3,000 ms (for HaCaT cells). (c) Four images from each slide (1e2 slides) of each

donor or passage at D2 and D4 were quantified for the number of DAPIþ cells per image. n ¼ 4 PHFKs, n ¼ 3 N/TERT2G cells, n ¼ 3 HaCaT cells.

Representative images were taken on D2. Bar ¼100 mm. #P < 0.05, *P < 0.05, ##P < 0.01, ****P < 0.0001. Shown is the mean � SEM of the data. D, day; ms,

millisecond; PHFK, primary human foreskin keratinocyte; TEER, transepithelial electrical resistance.

MC Moran et al.
Comparison of Keratinocyte Cell Lines

2

TEER values (Figure 1a). This is despite the fact that they do
appear to differentiate as noted by an increase in the differ-
entiation marker, cytokeratin (CK)-10 (Figure 2a). To ensure
JID Innovations (2021), Volume 1
that this barrier abnormality was not due to different culture
conditions, we cultured HaCaT cells in the media conditions
used for PHFKs and N/TERT2G cells. HaCaT cells were
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Figure 2. PHFKs, N/TERT2G cells, and HaCaT cells have approximately similar expression patterns of epidermal differentiation markers and TJ barrier

proteins. (a) Cell lysates were collected on D1, D2, and D3 after differentiation, and INVL precursor, CK-5 and CK-10, and TJ proteins CLDN1 and OCLN were

detected by western blot analysis. OCLN was not detected in HaCaT cells. Expression was quantified by densitometry with normalization to GAPDH

expression. (b) Representative blots. Molecular weight (kDa) approximation by ladder: 68 for INVL precursor, 58 for CK-5, 60 for CK-10, 23 for CLDN-1, 59 for

OCLN, and 37 for GAPDH. (n ¼ 4e7 PHFKs; n ¼ 5e8 N/TERT2G cells; n ¼ 3e6 HaCaT cells). Shown is the mean � SEM of the data. Mann‒Whitney U test

comparing D1 with D2 and D1 with D3 within each cell type. *P < 0.05, **P < 0.01. CK, cytokeratin; CLDN1, claudin-1; D, day; INVL, involucrin; OCLN,

occludin; PHFK, primary human foreskin keratinocyte; TJ, tight junction.
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cultured in KC serum‒free media (Invitrogen, Carlsbad, CA),
and at confluency, they were exposed to the media used to
induce differentiation in PHFKs and N/TERT2G cells (DMEM
with 1.8 mM calcium ion) (Thermo Fisher Scientific, Wal-
tham, MA). HaCaT cells did not develop barrier formation as
measured by TEER using these culturing conditions either,
suggesting that barrier formation as a result of high calcium
exposure is not possible in these cells (Figure 1a).

The movement of TJ transmembrane proteins to the cell‒cell
borders is a critical step in the formation of a robust barrier.
Immunofluorescence staining for the TJ transmembrane pro-
teins, OCLN and CLDN1, was performed on PHFKs, N/
TERT2G cells, and HaCaT cells. OCLN was the first TJ protein
identified, and it plays an important role in barrier function for
most epithelia (Saitou et al., 2000). Reductions in CLDN1 have
been observed in patients with atopic dermatitis, and Cldn1-
knockout mice die shortly after birth owing to cutaneous water
loss, implicating its importance in barrier function (De
Benedetto et al., 2011a, 2011b; Furuse et al., 2002). Two
days after differentiation, all the three cell types display
circumferential OCLN immunoreactivity and the formation
of the characteristic honeycomb pattern (Brewer et al., 2020).
The only KC cell line that showed distinct circumferential
staining for OCLN at day 2 after differentiation was PHFK; yet,
this pattern was still somewhat incomplete and was not seen
across the entire field (Figure 1b). By day 4 after differentiation,
www.jidinnovations.org 3
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Figure 3. PHFKs and N/TERT2G cells demonstrate similar CLDN1

reorganization during differentiation. Immunofluorescent staining of the TJ

protein CLDN1 on D2 and D4 after differentiation. Representative images

were taken at each time point. Images were captured with an exposure time

of 850 ms (for PHFKs and N/TERT2G cells) or 3,000 ms (for HaCaT cells).

Bar ¼ 100 mm. D, day; ms, millisecond; PHFK, primary human foreskin

keratinocyte; TJ, tight junction.
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the honeycomb pattern was very defined and observed
throughout the field in PHFKs. N/TERT2G cells demonstrated
clear circumferential OCLN immunoreactivity at day 4 after
differentiation, but this was less evenly distributed than that
demonstrated by PHFKs. This suggests that the localization of
OCLN to the cell‒cell borders is delayed in N/TERT2G cells
compared with that in PHFKs, which may explain their lower
TEER level. HaCaT cells showed minimal OCLN immunore-
activity, as demonstrated by its significantly longer exposure
time (3.5-fold longer) and diffuse localization (Figure 1b).

PHFKs and N/TERT2G cells also showed similar reorgani-
zation of CLDN1 during differentiation (Figure 3). On day 2
after differentiation, CLDN1 was localized in the nucleus,
with some cytoplasmic and circumferential localization. On
day 4 after differentiation, the circumferential localization of
CLDN1 in PHFKs and N/TERT2G cells was more distinct.
CLDN1 immunoreactivity remained localized to the nucleus
in HaCaT cells at both time points. CLDN1 contains a nu-
clear localization sequence, and its localization to the nu-
cleus has been previously reported (Hagen, 2017). Finally,
using the nuclear stain, DAPI, we observed that HaCaT cells
were both smaller and more densely packed than either
PHFKs or N/TERT2G cells (Figure 1c). This is consistent with
the smaller and more tightly packed pattern of OCLN we
observed in HaCaT cells (Figure 1b). Importantly, HaCaT
cells grow much faster than either PHFKs or N/TERT2G cells,
most likely owing to their cancer-derived nature (Boukamp
et al., 1988). Together, this supports the conclusion that
both PHFKs and N/TERT2G cells form distinct, honeycomb-
like TJ structures, albeit with slightly delayed kinetics in N/
TERT2G cells. In contrast, HaCaT cells do not have immu-
noreactivity for key TJ transmembrane proteins at their cell
surface even after 4 days of confluency.

The sharp, circumferential outline of OCLN and CLDN1
immunoreactivity observed in the PHFK images may in part
explain the higher TEER measurements. On day 2 after dif-
ferentiation, we observed the most significant difference in
TEER between PHFKs and N/TERT2G cells (Figure 1a). This
coincides with a more disorganized TJ protein localization in
N/TERT2G cells than in PHFKs (Figure 1b). On day 4 after
differentiation, whereas OCLN organization was still not as
defined in N/TERT2G cells as in PHFKs, the proteins were
JID Innovations (2021), Volume 1
beginning to localize to the cell‒cell borders (Figure 1b). This
coincides with continued increases in TEER and with a time
point (day 4) in differentiation when TEER is no longer
significantly different between N/TERT2G cells and PHFKs
(Figure 1a).

We next compared the expression patterns of key differ-
entiation markers by western blot. Expression of CK-5
(expressed in the stratum basale) and CK-10 and involucrin
precursor (both expressed in the stratum spinosum) were
quantified on days 1, 2, and 3 after differentiation (Leung
et al., 2020). We observed similar expression patterns of
these differentiation markers, with CK-10 expression
increasing, and slight decreases in CK-5 and involucrin pre-
cursor as differentiation progressed (Figure 2a and b). HaCaT
cells demonstrated similar but less consistent expression
patterns than PHFKs and N/TERT2G cells. Protein expression
of the TJ proteins, CLDN1 and OCLN, increased over time in
PHFKs and N/TERT2G cells, aligning with TEER formation
(Figures 1a and 2a). OCLN was not detected in HaCaT cells
by western blot, which is consistent with our observation that
the immunofluorescent staining required substantially higher
exposure times to visualize immunoreactivity (Figures 1b and
2a). This differs from the findings of a previous study in which
OCLN was detected in HaCaT cells by western blot (Aono
and Hirai, 2008). It is important to note that the OCLN an-
tibodies used in the assay in this study were polyclonal
(Zymed Laboratories, South San Francisco, CA) whereas ours
was monoclonal and from a different manufacturer (Invi-
trogen). In addition, the media used to culture their HaCaT
cells had a substantially higher concentration of calcium (9.8
mM) than those used by most investigators (1.8 mM) in the
field of epidermal biology (Bikle et al., 2012; Goleva et al.,
2019; Howell et al., 2008), which could explain the con-
founding observations. Furthermore, it was acknowledged
that culturing of HaCaT cells with the traditional calcium
concentration of 1.8 mM did not allow for the formation of
TJs (Aono and Hirai, 2008). As noted earlier, this may explain
the lack of TEER in HaCaT cells (Figure 1a). Interestingly,
HaCaT cells expressed CLDN1 (predominantly in the nu-
cleus), despite the fact that they did not form a robust barrier
as measured by TEER. This disparity suggests that these cells
may have an abnormality in the trafficking of TJ-associated
transmembrane proteins to the cell surface, which was sug-
gested by our immunofluorescent staining (Figures 1b and 3).

Our laboratory has had a longstanding interest in under-
standing why patients with atopic dermatitis have enhanced
susceptibility to cutaneous pathogens (Beck et al., 2009; De
Benedetto et al., 2011b). The skin microbiota of patients with
atopic dermatitis is dominated by Staphylococcus aureus
colonization, and skin colonization strongly correlates with
disease severity and barrier disruption (Kong et al., 2012;
Simpson et al., 2018; Tauber et al., 2016). We therefore
evaluated TEER changes in response to stimulation with
S. aureus supernatants. We found that PHFKs and N/TERT2G
cells responded similarly to supernatants from USA300, a
highly virulent strain of community-associated methicillin-
resistant S. aureus. Specifically, we observed a significant
reduction in TEER, providing further evidence that N/TERT2G
cells respond similarly to PHFKs (Figure 4). We noted that the
TEER reduction after USA300 treatment in N/TERT2G cells
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Figure 4. Treatment with Staphylococcus aureus supernatants significantly decreases barrier function in PHFKs and N/TERT2G cells. Cells were grown to

confluence and switched to media containing calcium (1.8 mM) to initiate differentiation (PHFKs, N/TERT2G cells); HaCaT cells were grown in recommended

media. TEER was measured in cells with and without exposure to S. aureus supernatant at 15 mg/ml (n ¼ 5 PHFKs and N/TERT2G cells; n ¼ 3 HaCaT cells).

Mann‒Whitney U test. *P < 0.05, **P < 0.01. Shown is the mean � SEM of the data. D, day; PHFK, primary human foreskin keratinocyte; TEER, transepithelial

electrical resistance.
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was a bit delayed compared with that in PHFKs. We specu-
late that this is a result of the low TEER values observed from
N/TERT2G cells early during differentiation, which makes it
difficult to detect changes in TEER after the USA300 treat-
ment. PHFKs form a robust barrier following differentiation,
making it easier to detect TEER changes in response to
treatments. Characterizing the effects and understanding the
mechanisms of S. aureus supernatants on TJ organization and
differentiation are the focus of ongoing studies.

It has been shown that changes in barrier function can alter
susceptibility to viral infection and that disrupted epidermal
barrier and altered KC differentiation are often observed
together (De Benedetto et al., 2011b; Guttman-Yassky et al.,
2009; Schleimer and Berdnikovs, 2017). We tested whether
PHFKs and N/TERT2G cells have similar susceptibility to
vaccinia virus infection at different stages of differentiation.
We chose vaccinia virus because it is a viral pathogen that
uniquely affects patients with atopic dermatitis, leading to
severe viremia and causing a life-threatening condition
called eczema vaccinatum. We observed similar patterns of
susceptibility, whereby undifferentiated and PHFKs and N/
Figure 5. State of differentiation determines susceptibility to viral infection in P

vaccinia virus while Undiff, at the time of differentiation (D0), or 2 days after diffe

to visualize plaque formation (arrow). (a) ImageJ was used to calculate the perc

Representative images of crystal violet plates and plaques. n ¼ 5 PHFKs; n ¼ 4 N/

0.05. Shown is the mean � SEM of the data. D, day; MOI, multiplicity of infect
TERT2G cells infected on day 2 after differentiation were less
permissive to vaccinia virus infection. Both PHFKs and N/
TERT2G cells were highly susceptible to vaccinia virus
infection when cells were infected at the time of initiating
differentiation by exposure to calcium-containing media
(Figure 5). These data suggest that PHFKs and N/TERT2G cells
become highly susceptible to infection with vaccinia virus
within the first 24 hours of differentiation, since cells were
exposed to the virus during that time period of the differen-
tiation process. We hypothesize that the increased suscepti-
bility to viral infection observed when KCs are infected at the
time of differentiation is a result of the remarkable changes in
gene expression that occur when differentiation is induced in
KCs (Toufighi et al., 2015). Understanding how differentiation
influences susceptibility to infection is also the focus of the
ongoing research.

In summary, we have shown that N/TERT2G cells faithfully
recapitulate primary human KCs. This immortalized cell line
circumvents the limitations of PHFKs, such as donor vari-
ability, limited cell divisions, and poor scalability. It is
important to note that most laboratories working with
HFKs and N/TERT2G cells. Cells were infected with a low MOI (0.0001) of

rentiation (D2). Plates were stained with crystal violet 48 hours after infection

entage of the monolayer within each well that was cleared by plaques. (b)

TERT2G cells. Significance was calculated using the Kruskal‒Wallis test, *P <

ion; PHFK, primary human foreskin keratinocyte; Undiff, undifferentiated.
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Table 1. Antibodies Used for Western Blot Analysis

Antibodies Manufacturer Dilution

Anti-CLDN1 (519000) Invitrogen 1:1,000

Anti-GAPDH (0411) HRP Santa Cruz Biotechnology 1:5,000

Anti-cytokeratin 5 (EP1601) Abcam 1:5,000

Anti-keratin 10 (Poly 19054) BioLegend 1:1,000

Anti-involucrin (Poly 19244) BioLegend 1:1,000

Anti-occludin (OC3F10) Invitrogen 1:500

Anti-mouse IgG HRP (NA931V) Sigma-Aldrich 1:5,000

Anti-rabbit IgG HRP (NA934V) Sigma-Aldrich 1:5,000

Abbreviation: HRP, horseradish peroxidase.
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primary cells acknowledge that many PHFK preparations do
not propagate well and therefore cannot be used for in vitro
experiments. In our hands, w30% of isolated KCs do not
propagate or develop barrier function (i.e., elevations in
TEER) and therefore cannot be used in experiments. This
identifies the need for alternative KC models that provide a
more robust and reproducible epidermal model. Finally, an
immortalized cell line such as N/TERT2G provides the op-
portunity to genetically manipulate the expression of key
proteins using techniques such as CRISPR/Cas9 as we have
recently shown with the knock down of CLDN1 and CD40
(unpublished data). The studies presented in this paper sup-
port N/TERT2G cells as a suitable alternative to PHFKs for
numerous assays important to skin biology.

MATERIALS AND METHODS
Cell cultures

PHFKs were isolated from discarded human neonatal foreskin tissue.

Patient consent for experiments was not required because human

tissue left over from surgery was deidentified and was considered

discarded material. The use of deidentified and discarded human

skin tissues for research use was approved by the Research Subject

Review Board at the University of Rochester Medical Center

(Rochester, NY) (URMC IRB STUDY: 00004672). Isolation and

propagation procedures for PHFKs were done as previously

described (Poumay and Pittelkow, 1995; Poumay et al., 1994). N/

TERT2G cells were provided by Ellen H. van den Bogaard and grown

as previously described (Dickson et al., 2000; Smits et al., 2017).

HaCaT cells were grown in DMEM containing 10% fetal bovine

serum and penicillin, streptomycin, and amphotericin additives.

PHFKs and N/TERT2G cells were switched to DMEM media sup-

plemented with 1.8 mM calcium ion and 4 mM glutamine (Thermo

Fisher Scientific) to induce differentiation. Days after differentiation

referred to the number of days since exposure to the supplemented

DMEM. For HaCaT cells, in which there was no media switch to

induce differentiation, days after differentiation referred to the

number of days since cells became confluent.

S. aureus culturing

The S. aureus strain USA300 (FRP3757) was grown, and supernatants

were filtered as previously described (Moran et al., 2019). Protein

content was determined using the Pierce BCA Protein Assay Kit

(Thermo Fisher Scientific).

TEER

TEER measurements were done as previously published (De

Benedetto et al., 2011b). Measurements of TEER were taken for up

to 6 days after the initiation of differentiation and exposure to

USA300 supernatant.

Immunofluorescent staining of TJ formation in PHFKs,
N/TERT2G cells, and HaCaT cells

PHFKs, N/TERT2G cells, and HaCaT cells were plated onto sterilized

glass coverslips and stained for immunofluorescent analysis for OCLN,

CLDN1, and DAPI as previously described (Brewer et al., 2020).

Immunofluorescent imaging of OCLN, CLDN1, and DAPI
staining using fluorescent microscopy

PHFK, N/TERT2G, and HaCaT slides were imaged using SPOT RT3

(Diagnostic Instruments, Sterling Heights, MI) on an Olympus BX60

fluorescent microscope, and ImageJ software was used to analyze

the images. All DAPI-stained images were acquired at 100
JID Innovations (2021), Volume 1
milliseconds exposure. OCLN and CLDN images were acquired at

850 milliseconds exposure for PHFKs and N/TERT cells. OCLN and

CLDN images of HaCaT cells were acquired at 3,000 milliseconds

exposure. Four DAPI-stained images were captured from each donor

or cell passage on day 2 and day 4 after differentiation. Quantifi-

cation of DAPIþ foci per image was accomplished in ImageJ using

the threshold function to remove background noise and to convert

the image to black and white. After this, the watershed tool was used

to outline individual cells. The analyze particles function was used

to quantify nuclei-sized pixels using a pixel range of 500 to infinity,

which was chosen to exclude the pixels too small to be nuclei. Each

data point represents the number of DAPIþ foci in each image of n ¼
4 PHFKs, n ¼ 3 N/TERT2G cells, and n ¼ 3 HaCaT cells (1e2 slides

per donor or passage, four images per slide).

Western blot analysis

PHFKs, N/TERT2G cells, and HaCaT cells were grown to confluency.

Differentiation was induced in PHFKs and N/TERT2G cells (DMEM þ
1.8 mM calcium ion þ 4 mM glutamine), whereas HaCaT cells

remained in standard culture media. Cell lysates (RIPA buffer [Boston

BioProducts] containing protease and phosphatase inhibitors [Sigma-

Aldrich, St. Louis, MO] with 0.2% SDS [Thermo Fisher Scientific])

were collected on days 1, 2, and 3 after differentiation. Samples were

run on Invitrogen NuPAGE 4e12% Bis-Tris gels and transferred to

polyvinylidene fluoride membrane (Bio-Rad Laboratories, Hercules,

CA). Membranes were probed with the antibodies shown in Table 1.

Antibodies were detected using SuperSignal West Pico PLUS

Chemiluminescent Substrate (Thermo Fisher Scientific). Relative pro-

tein expression was determined by densitometry calculated using

ImageJ software. Samples were normalized to GAPDH expression and

protein content (Pierce BCA Protein Assay Kit).

Vaccinia virus infection assay

PHFKs and N/TERT2G cells were plated at a density of 150,000 cells

per well in a 24-well plate. Cells were infected with a low multi-

plicity of infection of the Western Reserve strain of vaccinia virus

(multiplicity of infection of 0.0001) while undifferentiated, at the

time of differentiation, or 2 days after differentiation. Infection media

were removed 24 hours after infection and replaced with fresh

media. Crystal violet was added to the cells 48 hours after the initial

infection. ImageJ software was used to calculate the percentage of

the monolayer within each well that was cleared by plaques. To do

this, each well was selected with the region of interest tool (circle),

and the image was duplicated (right click, duplicate). The total area

of the circle was determined by using Analyze ->Measure. Next, the

outside of the circle was cleared using the Edit -> Clear Outside
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command; then the threshold function was applied to the image so

that the cleared monolayer (plaques) is white: Image -> Adjust ->

Threshold -> Apply. Finally, all area considered to be plaques was

selected using the Edit -> Selection -> Create Selection, and the

selection was inverted using the Make Inverse function. The area

covered by plaques was measured as described earlier (Analyze ->

Measure), and the area covered in plaques was divided by the total

area to get the percentage monolayer cleared.

Statistical analysis

Statistics were run using GraphPad Prism (GraphPad, San Diego,

CA). Mann‒Whitney U tests were used for analysis. Kruskal‒Wallis

test was used for Figure 5.
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